
																						 Space Dungeon 2.0b4

Thank you for downloading Space Dungeon. I would like it if you E-mailed me at
TheGiant13@aol.com with any suggestions, comments, likes, or dislikes.
Or visit my homepage at http://homepage.mac.com/giantmike

System Requirements:
68030, 68040, or PowerPC processor
System 7.0 and above
640x480 or better resolution
256 or more colors
4 MB RAM

What is Space Dungeon?

	Space Dungeon is a fun, addictive game that I programmed in my spare time. In this arcade game, 
you will need a good combination of skill and luck to achieve high scores.
	The object of Space Dungeon simple. You are lost in a dungeon somewhere in space (hence the 
name). While you explore the dungeon, you gather gold and try to keep from getting killed from 
the various monsters. But don't fret, there are many items scattered about to help you on your 
way. While you are exploring, you will no doubt find an exit, but is it really the exit, or does it bring 
you deeper into the dungeon?
	While this game may not win any accolades for it's graphics, the game play is quite fun. I have 
received great comments from others players. Also, it was featured in the April,1997 Takarajima 
magazine (published in Tokyo) under the category "Best U.S. Shareware Games of the Year."

How much does it cost?
	This game does not cost a single penny.

Who made those wonderful graphics?
	My good friend, Joel Schou, made those awesome graphics. I'm not kidding when I say he is the 
best computer artist I know. Give him a big hand by visiting his website at 
http://www.vault25.com/biggshoe

How are High Scores achieved?

	 High Scores come from a combination of getting as much gold as possible, and killing monsters to 
get experience. The total score for the High Scores list is computed as follows: Score = Amount 
of gold + (Amount of experience *100). The reason for doing this is simple. It keeps you from just 
getting gold and avoiding the monsters.

How do I move?

	You can either click the mouse on a tile next to you, or use a set of keys. To set the keys, select 
Preferences from the Edit menu or hit Command - P. To pick up an item, move on top of it. To kill 
a monster click on it, or hit the key in the direction of the monster.
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After I kill a monster, sometimes my Hit Points go up. Why is this?

	When you kill a monster, you gain experience. When your experience reaches a certain height, you 
will gain a level. As a reward for doing this, your Hip Points get a boost. The higher the level, the 
more Hit Points you will get.

Is there a limit to how many hit points I can get?
	Nope. You can constantly get more hit points, but that doesn't mean you will live forever. The 
monsters get stronger on higher levels, so you need all the hit points you can get.

What is this thing on the bottom of the screen "You are: Not Poisoned"?

	This is a new feature�s in Space Dungeon 2.0. The "You are: Not Poisoned" is the poison indicator. 
If it turns to "You are: Poisoned!", you are poisoned, and must find the antidote quickly. While you 
are poisoned, your Hit Points will decrease.

How about those monsters?

•The Troll.  He is the monster you will probably see the most, but is the
		easiest to kill.  He is classified as an easy monster.
•The Alien.  He is a little harder to kill than a troll, but still not very 
		hard.  He is also a easy monster.
•The Space Ship.  He has more armor than an alien, but not allot.  He is a
		easy/medium monster.
•The Blob.  He is easier to kill than a space ship, but takes off more hit points.
		He is also a easy/medium monster.
•The Gold Man.  He is about as hard to kill as the space ship, and takes off
		as many hit points as the blob.  But he gives you a sum of money when you beat him.
		He is also a medium monster.
•The Robber.  He is about the same a gold man, except when he hits you, he takes
		money from you along with the hit points.  He is a medium monster also.
•The Eyeball.  The eyeball takes off more hit points than a robber, but is
		about as easy to kill.  He is a medium/hard monster.
•The Dinosaur.  He only comes around when you have over 100 experience
		points.  It's a good thing too.  He takes off quite a few hit points, and is somewhat
		hard to kill.  He is a hard monster.
•The Bomb.  This only comes when you have over 130 experience points. This
		thing takes off a random number of hit points.  He is also hard to kill.  If you see one, 
		and you have less than 50 hit points, you should probably run!!!
•The Nuke. The nuclear bomb only come when you experience is over 200. It will take
    15 hit points off every time it hits you! Nevertheless you will kill it in very few hits.

Now about those items?

•First there is the Gold.  They don't give you allot of money, but if there is a
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		bunch of them, they will add up.
•Next there is the Diamond.  It gives you a considerable amount of money.
•Then there is the Latinum.  These give you allot of money.
•Next is the Bag of Money.  This one is a little different.  The bag could contain real or
		counterfeit money.  If it's real, you gain money, but if it's fake you lose money (but not
		too much).
•Then we have the Dice.  This is a real gamble.  You can lose allot or gain allot of
		money.  Only get this if you're a risky person.
•Next is the Healer.  With this item you can gain from one to five hit points, and is a
		very helpful item.
•Then there is the ?Healer?.  With this item you can lose up to four hit points, but
		gain up to five hit points.
•Finally there is the Super Healer.  This item only comes
		when you have over 100 experience points.  This gives you a random number of hit points
		much higher than a normal Healer.  This can be the most helpful item.

What is this Exit tile?

	The Exit tile, when stepped on, brings you to a new room in the dungeon with more gold, items, 
and monsters.  This can get you out of a whole heap of trouble if you are surrounded by a lot of 
monsters. But you can miss gold if you exit the room too early.

Well now it's time to get to the game GOOD LUCK!!!

Version History
	The version history has now been moved to a separate document.
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�                       Space Dungeon 2.0b4 Version History

1.0 
     -The First release of Space Dungeon.

1.1 
     -There was a bug that only affected OS 8 and above that would freeze the computer if you
         selected Show High scores from the File menu. This has been fixed.

1.2 
     -After making the Show high scores menu work, clear high scores refused to work under
         OS 8.0 and above, but now it does.

1.2.1
     -A few minor improvements in the high scores dialog.

1.3
     -I'm now using Metrowerks Codewarrior IDE 1.4.2 instead of 1.4 to compile the program.
     -Asynchronous sounds at last!
     -Replaced all Alerts with Dialogs.
     -Another minor improvement in the high scores dialog.
     -Confirmation Dialog for Clear High Scores.
     -Two sound channels.
     -The Super Healer is more random.
     -More extensive Help.
     -You can now turn sound on and off.
     -If you die twice(i.e. One monster kills you, than another in the same turn) The high score
         will only be checked once.
     -Negative scores are no longer treated as positive scores with the high scores list.
     -Added the Nuke enemy.
     -Dice now give out more money.
     -Fixed a bug that if the main window was moved, and Show high scores, Clear high scores,
         or you got a high scores, a new window would be drawn in the place it was originally.
     -Added "Click to continue" in the high scores window to make it more obvious how to
         dismiss the window. Along with minor improvements to this window.
     -The number of levels was increased from 15 to 20.
     -Minor improvements in the Score bar along the bottom of the screen.
     -Minor Hit point adjustments.
     -The keys are no longer hard coded!!!! Woo Hoo!

1.3.1
     -A new High Scores menu has been created to alleviate some of the cluster in the File
          menu.
     -The first Help Menu has been removed to stop the confusion of two Help menus in OS 8.5
          and placed the Space Dungeon Help under the real Help menu.
     -An Edit Menu has been added to make the program more "Mac-like".
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     -The Keys and Sound Menu Items have been combined into a single preferences Dialog and
          placed in the Edit menu.
     -Some unnecessary Dialogs and graphics which made the size of the program smaller.
     -The Collapse box has been taken out of the High Scores! window.
     -If Space Dungeon is unable to create a Preference file, it now gives an alert dialog before
          quitting instead of just quitting.

1.3.2
     -Fixed a tiny bug in the Preferences file that didn't really affect anything.
     -When Clear High Scores was selected, the Confirmation Dialog remained until you
          dismissed the High Scores! window. Now the Dialog is dismissed properly.
     -Now when the High Scores! window is displayed, the button on the little mouse picture
          blinks. I know very rapidly, but I can't help that.
     -Added the arrows in the preferences to make it "look better", and to make it easier to
          navigate.
     -Now there are 'Previous' buttons in the last two Help dialogs.
     -Added a defaults button to the Preferences dialog.
     -It now checks to see if you have color, System 7 or above, and a 68030 or above.
     -Now when you click the mouse to get rid of the High Scores! window, it no longer gets
          registered as a game click. It only dismisses that window.
     -The is now a Game Over! picture that goes over the main window when you die. Otherwise,
          you may think that the game froze when it was really just waiting for you to select
          New Game.
     -The Help key now activates the help system.

1.3.3
     -Added "Your Score:" followed by your score to the bottom of the High Scores window when
          the Show High Scores menu is selected, or when you die.
     -Added "High Scores have been erased!" to the bottom of the High Scores window when the
          Clear High Scores menu is selected.

2.0b1
     -You now start out with 15 Hit Points instead of 10.
     -There are now 25 Levels.
     -You can now get poisoned. (Info on this earlier in the Read Me).
     -You can now run out of water. (Info on this earlier in the Read Me).
     -Moved the window up to make sure it fits (with the new addition to the bottom) on a 
          640x480 monitor.
     -The Cursor is now a "looking down the barrel of a phaser rifle".
     -You can now dismiss the High Scores via either clicking the mouse button, or hitting a
          keyboard key.

2.0b2
     -The bug which did not register the click directly after the high scores are dismissed is
          now fixed.
     -The word "Congratulations" in the high scores dialog is now spelled correctly.
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     -New Eyeball and Money Bag graphics
     -Hopefully squashed a bug where the sound would go out if using GoMac and certain screen�
�          savers.

2.0b3
     -All new graphics thanks to Joel Schou!
     -The water item has been removed due to popular demand.
     -All new About Space Dungeon Dialog box.
     -Poison doesn't kill you as fast now.
     -Updated the in game help system with new explanations, pictures, and items.
     -Removed "Click Mouse button to continue" In the high scores boxes, due to the ability to
          either click the mouse button, or press a key to continue.
     -If you get a high score, it will now be both red and green, plus bold for easier viewing.
     -A new preference file is created for Space Dungeon 2.0
     -Implemented new, safer functions for turing sound on and off.
     -The Creator code is now SD20.
     -Releases all sound handles upon quitting to eliminate any memory leaking.
     -With some help from Jason Kulas of iDevGames.com, I was able to produce a PPC version
          of Space Dungeon that doesn't crash when playing sounds. Thanks a bunch Jason.

2.0b4
     -It's now safer to pick up dice, as you stand a much better chance of making money, and
          much less chance of losing money.
     -Getting poisoned at higher Hit Point levels is now more dangerous due toquicker deduction
          of Hit Points.
     -More Antidotes will appear in the next room (through an exit tile) if you are poisoned
          going through.
     -The Space Dungeon application now run nativly on 68k and PPCs.
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